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SUMMARY

The Acoustic Laboratory Data Acquisition System (ALDAS) is an inexpensive, transportable

means to digitize and analyze data. The system is based on the Macintosh II family of computers,

with internal analog-to-digital boards providing four channels of simuhaneous data acquisition at

rates up to 50,000 samples/sec. The ALDAS software package, written for use with rotorcraft acous-

tics, performs automatic acoustic calibration of channels, data display, two types of cycle averaging,

and spectral amplitude analysis. The program can use data obtained from internal analog-to-digital

conversion, or discrete external data imported in ASCII format. All aspects of ALDAS can be

improved as new hardware becomes available and new features are introduced into the code.

1.0 INTRODUCTION

The helicopter industry requires a more detailed analysis of acoustics data than it did in the past,

for correlation with increasingly sophisticated methods of acoustics prediction. Increasing concerns

about the ability to detect helicopters, and the increased ability to predict precise spectra, have gen-

erated the need for a low-cost, transportable, easy-to-use, digital acquisition and analysis package.

Typically, acoustics data has been acquired on analog tape and then either analyzed directly with an

analog-output narrow- or octave-band analyzer, or digitized with a minicomputer-based system and

analyzed through software.

The analog-output analyzer imposes many user and operational limitations. These limitations

include strictly controlled input duration and output resolution, and a restricted number of input

channels--typically only one or two input channels are available at a time. Another limitation is that

although most analyzers can transport the results to other types of machines, they frequently cannot

transfer the exact set of analyzed data for further analysis or display.

The minicomputer-based technique overcomes many of the limitations of the analog-output

devices. It is versatile, it can handle simultaneous input data channels, and the data can be saved and

used by other applications or machines. However, the minicomputer-based system is not easily

transportable and can be expensive. The Acoustic Laboratory Data Acquisition System (ALDAS)

incorporates the advantages of the minicomputer system while overcoming its two major limitations.

2.0 SYSTEM SPECIFICATIONS

ALDAS is primarily geared for the in-flight acoustics data acquired by the YO-3A Acoustics

Research Aircraft (ref. 1). The YO-3A aircraft is essentially a quiet microphone platform that

acquires and records data while flying in formation with the research aircraft. ALDAS specifications

are listed in table 1 and explained below.
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Table 1. ALDAS system requirements

System requirements System specifications

4-channel simultaneous digitization 4-channel simultaneous digitization

2. 16-bit digitization on allchannels 3 channels at 16 bits

1 channel at 12 bits

3. 0 to 45,056 samples/sec 0 to 50,000 samples/sec

4. Easily transportable system Macintosh g-based system

5. Easy-to-use system System uses Macintosh interface standards

6. 3,604,480 samples of data accessible

. Data interchangeable with other systems and

codes

Currently can access 1,500,000 samples

but will be upgraded in future to

7,675,000 samples

Imports and exports ASCII data files

1. Four-channel simultaneous digitization. The YO-3A has three microphones, one on each

wingtip and one on the vertical tail tip. Since flight data is unsteady in nature (no matter how

"steady" the flight condition), the acoustics data must be digitized so that no phase shift exists

between microphones. In addition, the YO-3A acoustics data and the helicopter data are related by a

common time code or once-per-revolution pulse (1P), which is recorded on both aircraft. It is neces-

sary to digitize the time code or 1P at the same time as the three acoustics signals in order to tie the

data together. Thus, the requirement for the number of simultaneous channels is four.

2. Resolution: three channels at 16 bits, one channel at 12 bits. Acoustics data, by its nature, is

composed of many waves, with a wide variation between wave amplitudes. This variation results in

amplitudes at the off-harmonic frequencies that are much lower than those at the harmonic frequen-

cies. To guarantee that the noise level in the acoustics data is low enough to allow the low-amplitude

variations to be resolved, 16-bit analog-to-digital resolution is required. However, since only three

channels are needed for the microphones on the YO-3A, and the fourth channel is for the 1P or time-

code pulses, the resolution for the fourth channel does not have to be as great. Ahhough 16 bits is

desirable, 12-bit resolution is adequate for the fourth channel.

3. Data acquisition rate: 0 to 50,000 samples/sec. ALDAS should be usable for a wide range

of aircraft tests, yet maintain an adequate resolution in the time axis. A data-acquisition rate of
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4096samples/revis assumedto beadequatefor all rotorcraftapplicationsof thedata,androtation
ratesof 4.5to 11.0rev/secaretypicalfor full-scalerotorcraft.This yieldsamaximumsample-rate
rangerequirementof 0 to 45,056samples/sec.

4. MacintoshII-basedsystem.Frequently,acousticstestingtakesplaceat remotesites.The
ability to reducetheacousticsdataatthesesitesbetweenflights is usefulto ensurethatthetest
acquiresthebestavailabledataset.Thus, ALDAS must be easily transportable and must not have

special environmental requirements or an extensive setup time.

5. Macintosh interface standards. The system should be easy to use.

6. Number of accessible data samples: currently 1,500,000 samples, but will be upgraded in the

future to 7,675,000 samples. ALDAS must be able to handle several seconds of data per channel for

all channels concurrently. Typically, to eliminate unsteady effects, several cycles of data are aver-

aged to yield a representative cycle, but plotting several cycles of the raw data aids in tracking

anomalies in the averaged cycle. Data sets of up to 45,056 samples per second per channel for

20 seconds and four channels, or up to 3,604,480 samples of data, should ideally be accessible at a
time.

7. Imports and exports ASCII data files. Data must be interchangeable with other computer

systems and codes.

3.0 SYSTEM DESCRIPTION

ALDAS consists of three parts: the microcomputer, the analog-to-digital boards, and the

acquisition/analysis software. The data can enter ALDAS from an external ASCII file, an analog

tape recorder, or directly from the microphone outputs.

The microcomputer chosen was the Macintosh II series because it is easy to use, has good

graphics capability, is widely available at low cost, and can be easily transported. The original

system, which was developed for the Macintosh II, was easily converted when the Macintosh IIx

was introduced. Although the Macintosh II is perhaps underpowered in CPU, clock speed, and

memory capacity for this application, the Macintosh IIx and future machines show excellent growth

in CPU capability, with the advantage of maintaining software compatibility with earlier machines.

The current 8-Mbyte-RAM limit of the machine does not meet the maximum data-samples require-

ment. However, the release of the Macintosh Operating System 7.0, and the introduction of 4-Mbyte

SIMMs as well as virtual memory configurations, will overcome this limitation in the near future.

The analog-to-digital boards selected were the GW Instruments MacAdios II motherboard with

three GWI-HAD daughter boards. These boards most closely met the system requirements at the

time of procurement. (New products and improvements are continually being introduced, many

of which might readily be used for ALDAS and perform as well, or better than, the current con-

figuration.) The software developed for ALDAS can be easily modified to accommodate different

brands of analog-to-digital boards. The MacAdios II motherboard is a 12-bit internal board that has a



maximumrateof 144,000 samples/sec. The daughter boards are 16-bit with a maximum rate of

50,000 samples/sec, and they physically mount on the motherboard. These boards can be externally

triggered, can run on an external clock, and can acquire the four channels of data simultaneously.

The acquisition/analysis software, or ALDAS Program, was written in Lightspeed Pascal to con-

form to the Macintosh User Interface Guidelines (ref. 2). This program controls the analog-to-digital

boards, the import/export of ASCII data, the analysis of data, and the display of raw or analyzed

data. General ALDAS Program features are

• Automatic calibration of channels

• Scrollable data-viewing windows for up to four data sets

• Automatic input of user-selected data points into data lists

• Two methods of averaging

-- using on-input low-high trigger

-- using user-selected start points in time history

• Digital filtering using two data-window types

• Spectral analysis using eight data-window types

• Graphics output to printer

• User-selectable

data type (choices are Acoustics and General)

-- viewing resolution of data

x and y display units on data plots

channel combinations for analog-to-digital conversion

• Can save data in ASCII format for input to other programs

• Can import data in ASCII format

• Can save and recall digitizing settings

The remainder of this manual will concentrate on the discussion of these features and instructions

for their use.



4.0 ALDAS PROGRAM USER INSTRUCTIONS

These user instructions will start with general information about the Macintosh interface and then

follow the functional lines of the program, starting with data acquisition, display, and analysis. This

organization was chosen to give the user a feel for how to apply, as well as how to use, the program.

4.1 General Menu and Dialog Information

Like any Macintosh application, the ALDAS Program relies on commands found in menus, or

their keyboard-command equivalents, to initiate actions. The ALDAS Program uses three types of

menus, shown in figure 1: pull-down, hierarchical, and pop-up. Pop-up menus appear only in dialog

boxes and windows; pull-down and hierarchical menus are activated from the ALDAS Program's

main menu, which appears when the program is started.

Undo

Cut

copy, 
P'aste _j

(a) Pull-down. (b) Hierarchical,

Pop Up Menu: I Entry 21

(c) Inactive pop-up. (d) Active pop-up.

Figure 1. Menu types.

A composite of the pull-down and hierarchical menus for the ALDAS Program is shown in

figure 2. The keyboard-command equivalents for the menu items are indicated to the right of the

menu commands and are summarized in table 2. If a solid right arrowhead (_) is in the keyboard

command location, then a hierarchical menu is present and can be activated by dragging the mouse

pointer over the arrowhead. An ellipsis (...) after a menu item indicates that choosing that command

will activate a dialog box (described below). The absence of an ellipsis is an indication that the

command will usually be performed without a dialog box. However, some graphics options are not

compatible with some data types, and the combination of a commanded option and an incompatible

data type will force a dialog box to appear.



Table 2. ALDAS program keyboard commands

Character

key

1,2,3,4

Command key combination

I

fig-Option _-Shift -Option-Shift

C

E

N

P

Q

T

V

X

Bring plot

window x to

front

Copy

Save as ASCII

data

Import ASCII

data

Amplitude

Spectrum

Activate x list

window

Amplitude

Spectrum

Analysis Go Analysis Options

Print front graph

Quit

Time History Go

Paste

Cut

dialog box

Time History

Options dialog

box

[Reserved for

system]

Bring x list

window to front

if list active
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I_ File Edit Font Size Accuire Anakze Plot

Save Settings ,..
Load Settings ...
Print Settings .,.

Save as ASCII ... _¢e

Import ASCII.., _¢i
Print Graph _¢p

............

About ALD.A__S..-.

.........

I Calibrate ...Digitize ...

WindowsSpecial

Window I X1

Window 2 X2
Window 3 _¢3
Window 4 3¢4

) _i Activate _¢-O (1,2,3,4)

LiStlList2 : _.Bring To Front _¢-O-S (1,2,3,4)List 3 .........................

........: C°,,s
FFT Windows) ,,.-- Rectangular
FFT Options .,. Hannlng
Edit Info ... Tenth Cos Taper

Quarter Cos Taper
Kaiser-Bessel
Parzen
Welch
Blackman Harris

T

IT,m°.,sto . looIOptions ... X-O t
7

Average ... _t_ J
Amp. Spectrum ) Go X n

Digital Filter ... Options ... _¢-O n

Figure 2. ALDAS Program menu choices.

Dialog boxes are the way that certain options are chosen and control data is input to the ALDAS

Program. The two types of dialog boxes are modal and modeless; their formats are shown in fig-

ure 3. Modal boxes have no title bar across the top and require an action such as clicking on the

Continue or Cancel button before anything else can be done by the machine. In contrast, modeless

dialog boxes have a title bar across the top and act as normal windows, so actions not associated with

the dialog box can be performed even though the dialog box is active.

_Channell

(a) Modal. (b) Modeless.

Figure 3. Dialog box formats.



Windowsanddialog boxescontainseveraltypesof inputfields andcontrols:editabletext fields,
checkboxes,radiobuttons,controlbuttons,pop-upmenus,andscroll bars.Figure4 showswhat
eachof theselookslike (exceptpop-upmenus,whichwereshownin figure 1).Theinsertioncursor
canbemovedamongeditabletext fields within a windowor dialogboxbypressingthetabkeyor
clicking on thedesiredfield with themouse.Checkboxesandradiobuttonsareturnedonandoff by
clicking on them.Controlbuttonsareactivatedwhentheyareclickedon.Pop-upmenusappear
whenthemousebuttonis depressedandthepointerheldover themenuindicator.TheCancelbutton
alwaysclosesthedialogbox it is in without takinganyactionor retainingthevaluesenteredin that
dialogbox.

I
Static

Text ] Editable Text

(a) Text fields.

[-'] Channel 3 [_ Channel I

(b) Check boxes.

0 Time (_) Points

(c) Radio buttons.

[ Go J {Cancel)

(d) Control buttons.

!¢>1

(e) Scroll bar.

Figure 4. Standard Macintosh input fields and controls.
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4.2 Data in the ALDAS Program

Data can be input into the ALDAS Program via two methods: importing ASCII data, and con-

vening analog data (from a tape recorder or from microphone outputs) to digital. Data, once it is in

ALDAS, is considered to be either of general or acoustics type. The general data type can have any

units, whereas the acoustics data is defined to be in pascals. Both data types are stored in integer

form and use a linear calibration function as well as decibel gains and attenuations for conversion

from integer counts to real data.

4.2.1 Importing ASCII Data- Data from sources other than ALDAS can be imported through

the use of an ASCII input file, which must be in the form of one value per line, each line ending in a

carriage return. The procedure for importing data is as follows:

1. Choose Import ASCII from the File menu (see fig. 2). This activates the dialog box shown in

figure 5.

INFORMATION TO BE APPENDED TO THE IMPORTED DATA

Comment:

comment

date/time: [DD/MON/YR HA:MN:SC

Analog Gain: [0

Digital Gain: I I

Cal Slope: [ll.o

Sample Rate: [0

Number Samples: 0

Analog Filter Rate: [0

0 Rcoustics Data

I
Analog Attenuation: O

Cal Gain: 0

Cal Intercept: O.O

J Uni Is: _-e'cibels

(_ Real Data

_) General Data 0 Integer Data

I Cancel _ _ Continue 1

Figure 5. Import ASCII dialog box.
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2. In the editable fields, enter information pertaining to the data to be input. In the Number

Samples field, enter the number of lines of ASCII data in the input file. The Sample Rate is in

samples/sec. The Number Samples and Sample Rate fields must be nonzero to perfoml the data

input.

3. Click on either the Acoustic Data or General Data radio button to set the data type. This data

type can be changed later (see section 4.5.2).

4. Click on either the Real Data or Integer Data radio button to tell the input routine which is

being imported. If Real Data is checked, the program will calculate a slope and intercept for the data

set and convert the real values to integer count values in the range +32,700. If Integer Data is

checked, the program will save the integer values of the input stream and use the slope and intercept

entered in the dialog box.

5. To import the data after entering the information, click on Continue. To close the dialog box

without performing any action, click on Cancel.

When the Continue button is clicked, the Open File dialog box is activated.

1. Enter the requested information about the file from which the data is being imported.

2. Click on Continue.

ALDAS then reads the number of lines indicated in the Number Samples field and performs the

operations indicated by the choice of Real Data or Integer Data. A File dialog box is activated to

open the output file.

1. Enter the requested information about the file in which the imported data is to be stored.

2. Click on Continue.

The program then stores the data in the ALDAS-formatted file indicated in the File dialog box.

4.2.2 Analog-To-Digital Conversion- Analog-to-digital conversion is done in two steps:

acoustic calibration (section 4.2.3) and data acquisition (section 4.2.4). When making analog-to-

digital conversions, the ALDAS Program drives the GW Instruments boards. However, with

minimal program changes, other brands of analog-to-digital boards could be substituted. The follow-

ing aspects of the conversion should be considered when making these program changes.

For helicopters, whose data is normally considered on a per revolution basis, data analysis

involving fast Fourier transforms (FFT) is easier if the number of samples/rev is a power of two.

Figure 6 shows the number of samples/rev versus rotor rpm for a sample rate of 50,000 samples/sec.

The dashed lines indicate the samples/rev values that are a power of two. As can be seen, for normal

helicopter revolution rates (206 to 310 rpm), there is no problem getting up to 8192 samples/rev.

However, for tilt-rotor rates (516 to 660 rpm) and model-scale rates (1345 to 3300 rpm), a set of

digitizing boards with a higher samples/sec capability will be required to obtain high-resolution data.

l0



15000

0

10000
>

O.
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E 5ooo

Figure 6.

U , , • i • ° . I , . . ! • . , i

200 400 600 800 1000

Rotor Speed (rpm)

Samples/rev envelope for a rate of 50,000 samples/sec.

Also to be considered in obtaining a power-of-two samples/rev value is the discrete nature of the

determination of the sample rate for the GW Instruments boards. The sample rate (in samples/sec) is

determined by the equation

Sample Rate =
1,000,000

(range)(mult)

where

range = 1; 10; 100; 1000; 10,000

mult = 2, 3,4 ..... 6553

In most cases, the calculated sample rate will not be exactly the desired rate. The ability to connect

an external clock to the boards allow this shortcoming to be overcome.

Another consideration when configuring the analog-to-digital conversion is the voltage ranges of

interest. The available ranges for the GW Instruments boards are +10, +5, and +2.5 v; they are

selected by jumper blocks on the boards. If the input voltage exceeds the voltage range selected on

the digitizing boards, a band-edged signal results. Conversely, if the input voltage is very low com-

pared to the voltage range, low resolution and a low signal-to-noise ratio results. The normal practice

is to leave the boards set at a nominal value and use amplifiers to adjust the input voltage for optimal

performance.

11



4.2.3 Acoustic Calibration- The first step in analog-to-digital conversion is calibration. The

ALDAS Program performs an automatic acoustic calibration of a chosen channel, given a sine wave

calibration signal of a known frequency and amplitude. The acoustic calibration procedure is as

follows:

1. Choose Calibrate from the Acquire menu (see fig. 2). This activates the Cal Options dialog

box shown in figure 7.

Col Opt.ions ,,

Calibrate Channel:

I 2 3 4

O ® O O

Calibration Value: [114[ dB

Calibration Freq.: 1250 [ hertz

Calibration Gain: [ 0 [dB

Calibration Slope: 1 4.637247e-4

Calibration Off.: [ 1.295452e-I

Input Source: []File []Analog

( Start 1 (Cancel 1

Figure 7. Calibration Options dialog box.

2. Click on the radio button of the channel to be calibrated.

3. Enter the calibration value in decibels, the calibration frequency in hertz, and the calibration

gain in decibels. (Note that attenuation is negative gain.)

4. To choose an analog input signal, check Analog; to choose data input from an ALDAS-

formatted data file, check File. (Normal operating procedure is the Analog option.)

5. To start calibration after entering the information, click on Start. To close the dialog box

without performing any action, click on Cancel.

When the Start button is clicked, the ALDAS Program takes 20,000 samples of the input signal

at 20,408 samples/sec. The computer performs the acoustic calibration of the input signal by first

finding the root mean square (rms) value of the input sine wave amplitude,

12



cycles cycles

Z Maximum i- ZMinimumi

rms= i=l 2(cycle_l (0.707107)

where cycles is the number of sine wave cycles in the input signal, and Maximumi and Minimumi

are the maximum and minimum amplitudes of each cycle in counts. The calibration slope is then

calculated from this averaged rms value using

10 (CalAmp+CalGain)/20 (0.00002)
Slope = rms

where CalAmp is the Calibration Value and CalGain is the Calibration Gain in decibels from the Cal

Options dialog box. The calibration intercept is then calculated by multiplying the slope by the mean

signal value. Once the calibration has been calculated, the program performs a fast Fourier transform

(FFT) on the first 8192 points using a Hanning window (see appendix A for FFT window informa-

tion) to determine the quality of the calibration. Then a subset of the input data, the results of the

FFT, and statistical information on the quality of the calibration mean, amplitude, and frequency are

displayed in a calibration plot window, as shown in figure 8. The calibration slope and offset are

automatically copied to the appropriate digitizing channel; however, it is advisable to print the cali-

bration graph for permanent record using the Print Graph command on the File menu (see fig. 2).

4.2.4 Acquisition- Data is digitized through the use of the analog-to-digital conversion boards;

the procedure is as follows:

1. Choose Digitize from the Acquire menu (see fig. 2). This activates the Digitize Options dia-

log box shown in figure 9, and up to four channel dialog boxes, one of which is shown in figure 10.

The Digitize Options dialog box has two similar forms. In the default form, the per revolution

options are activated (fig. 9(a)); in the other form, these options are deactivated (fig. 9(b)).

2. Check the appropriate boxes, as described below:

Channel boxes: Used to select the channels to digitize. A channel dialog box is activated for
each selected channel.

/Rev Options box: Turns on the per revolution data-input options when checked. When not

checked, data input is continuous with time.

Pulse Trigger box: Triggers data acquisition externally on a low-to-high pulse when checked.

13



-[-] Plot Window I

I123190 5:26PM
Calibration Results of Channel 2

Calibration Slope = 4.637247e-4 Calibration Offset = 1.295452e-I
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dB 90,

70
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Data Point

300

I 12.0 dB, 249. I Hz

Hanning Window

660 960 12(D0 1500 1800
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Mean Statistics:

Mean = -279.36
St4. Dev. = 79.08

Max. Dev. = 61.44%

Amp. Statittict:
Mean =61138.48

Std.Dev. = 0.00

Max. Dev. --0.25%

freq. Statistic*:
Mean =250.45 Hz

$td. Dev. = 2.88Hz
2100 Max. Dev.= 1.86%

Figure 8. Calibration plot window.
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Digitize Options

Samples/Second

Seconds/rev

Hertz

/rev

Sample Rate: 41666

Sample Length:iO.200 [

Filter Rate:llOOOO I

Samples: 18192 1

# cycles [ I i

[] Channel I [] Channel 3

[] Channel 2 [] Channel 4

[]/Rev Options [] Pulse Trigger

Start Time: IOD/MON/YR HR:MN:SC I

IPrepareF°rDigitizingl I Cancel 1

Digitize Options

Sample Rate: 41666

Sample Length: 10.200

Filter Rate: IOO00

Samples: 8192

Samples/Second

Seconds

Hertz

[] Channel I [] Channel 3

[] Channel 2 [] Channel 4

[] /Rev Options [] Pulse Trigger

Start Time: I DD/MON/YRHR:MN:SC

IPrepare ForDigitizing_ I Cancel 1

(a) Per revolution options on.

Figure 9.

(b) Per revolution options off.

Digitize Options dialog box.

3. Enter the requested information in the editable fields, described below:

Sample Length: The duration in seconds of each revolution when/Rev Options is checked

and of the total input data when/Rev Options is not checked.

Filter Rate: The analog antialiasing-filter value.

Samples: The number of samples/rev when/Rev Options is checked, and the number of

samples of the total input data when/Rev Options is not checked.

# cycles: The number of rotor revolutions to digitize when/Rev Options is checked.

Start Time: A reference date and time, input by the user. This can be the time the data was

either acquired or digitized.

4. Enter the information for individual channels through the Channel dialog boxes, as shown in

figure 10. There is a separate dialog box for each channel; the data fields for these dialog boxes are

self-explanatory. If a channel was calibrated using the ALDAS Program acoustic-calibration proce-

dure described in section 4.2.3, the calibration-slope (Cal Slope) and calibration-gain (Cal Gain)

fields will contain the ALDAS values. These values can be altered by the user.

5. Click on the Prepare for Digitizing button in the Digitize Options box. This initializes the

proper variables and activates the Prepare for Digitizing dialog box shown in figure 11.
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_Channell

Comments:

Channell

Data Saved in File: IChannel I

Analog Gain: 0_ Decibels

Attenuation: I 0 I Decibels
I I

Digital Gain:_ Times

Cal Slope: I 1.0

Cal Gain: I 0

Intercept: I0.0

{_ Acoustics Data Q) General Data

Ready to start acquiring data!

Cancel 1

Figure 10. Channel dialog box. Figure 11. Prepare-for-digitizing dialog box.

6. To begin data acquisition, click Acquire Data or press the return key. To close the dialog box

without performing any action, click on cancel.

When the ALDAS Program finishes acquiring the data, one of two things wilI happen:

1. If/Rev Options was not checked, a File dialog box will be activated, allowing the program to

ask where to save the data and giving the user a chance to change the raw-data file name.

2. If/Rev Options was checked, the dialog box shown in figure 12 will be activated. Click on

the appropriate command button. If requested, the program will average the data on a cycle-by-cycle

basis to derive an averaged cycle and will save that averaged data. This option should only be used if

the rotor rpm is very constant or if the Pulse Trigger option was checked in the Digitize Options dia-

log box. The command buttons control the following actions:

:ave Averaged Data Only

Save Raw Data Only

Save Both 1

Figure 12. Post-digitizing dialog box.
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Save Averaged Data Only: Saves only the averaged cycle of data.

Save Raw Data Only: Saves the raw data only as a continuous stream; does not average the
data. Note that the data is saved as a continuous data stream with a constant time base

even if the data is discontinuous, because the Pulse Trigger was activated.

Save Both: Averages the raw data and saves both raw and averaged data.

Cancel: Returns control to the Digitize Options dialog box without saving any data.

When raw data is saved, the program inserts "Raw-" into the beginning of the file name. For

averaged data calculated by this method of averaging, the program inserts "Ave-" into the beginning

of the file name. Information from the dialog boxes is saved along with the data, and control returns

to the Digitize Options dialog box. The method of viewing this information and displaying the data
will be covered in section 4.3.

Since it is time-consuming to set up the digitizing parameters, a means of saving, restoring, and

printing these values has been included in the ALDAS Program. These functions are controlled by

the Save Settings, Load Settings, and Print Settings menu choices on the File menu (see fig. 2).

Save Settings: Saves the current digitizing settings in the designated settings file.

Load Settings: Restores the digitizing settings from a designated settings file to the current

settings file.

Print Settings: Prints the parameters for the current digitizing settings for all four channels,

Care should be taken when using saved settings if the configuration of the input source has changed,

because this may cause the calibration values to be different than those saved.

4.3 Data Display

All data either acquired, imported, or calculated by the ALDAS Program can be viewed in a

graphical form through the use of data plot windows, which are described in section 4.3.1. Data plot

windows are activated by choosing Amplitude Spectrum in the Analyze menu (see section 4.4.2) or

Time History in the Plot menu (see section 4.3.2). There can be up to four data plot windows open

on the desktop at any time. These windows can contain raw time-history data, a frequency spectrum,

or averaged time-history data. In general, the user can choose the x and y data units for the plot

requested. The axis units are chosen via the radio buttons contained in the Display Options dialog

box, which is activated from the Options submenu and shown in figure 13. The x-axis choices are

Points, Time, and Frequency, and the y-axis choices are Counts, Pascals, decibels, and General. Only

the x and y choices that apply to the type of data being displayed will be shown to the user.
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{_ Counts

0 Pascals

0 decibels

OGeneral

Display Options

{_}Points OTime OFrequency

1 I C°ntinue} ICancell

Figure 13. Display Options dialog box.

A useful side effect of the four data plot windows is the ability of the program to show a data

stream in two or more data plot windows at once, in either the same or different axis units. This

allows easy comparison of different parts of the data stream (see section 4.3.1), especially on a

system that has a large monitor.

An active data plot window that is hidden may be brought to the front by choosing the desired

window from the Windows menu (see fig. 2). Only the data plot windows that are activated are

accessible in this manner.

A data plot window can be printed when it is the front window. All information shown in the

window is printed. This printout is performed by choosing Print Graph from the File menu (see

fig. 2).

4.3.1 Common Data Plot Window Elements- Certain controls and indicators are common to

all data plot windows, independently of the type of data displayed. These common elements are

shown in figure 14, a screen image of one data plot window, and described below.

Cursor button: Toggles the cursor on and off when clicked. When the cursor is on, a vertical

cursor line appears in the plot frame; it follows the mouse pointer when the mouse pointer

is in the plot frame. In addition, above the Cursor button, the x and y values of the inter-
section of the data trace and the cursor line are displayed in the plot's x and y units.

Viewing Resolution radio buttons: Indicate the decimation factor, for the x axis, of the data

displayed. For example, if 1/2 is checked, every other point is plotted; if 1/4 is checked,

every fourth point is plotted. This allows the user to examine the data for trends and
choose where to look in more detail.
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Title
Area

Plot
Frame

File Edit Font Size Acquire Analyze Plot Special Window

-[-]_ _ _ Plot Window t _

Counts O

e 1 7, rnic 2Data File: Raw-e 1"7, mic 2

Analog Gain: I0

Analog A_ten:-20
Cat GaJn:-lO

Cursor Line

- 19055.00.

z7_o.ooo425°1°
y: 9238.00_ Data _ection: (_)0

Viewing Resolution: C) 2X

OL......... El ,= ...................
Data Point 302 1.0

@Full O 1/2 O !/4 O!/8 01/16

t Cursor Button and

Cursor Location

Figure 14. Common data plot window elements.

Data Section radio buttons: A dynamic set of radio buttons that indicate which 32,767-point

section of data is currently displayed in the plot frame. For example, if a data set has

68,054 data points, it will be divided for display into three sections: section 0, points 0 to

32,767; section 1, points 32,768 to 65,534; and section 2, points 65,535 to 68,054. Three

corresponding Data Section radio buttons, labeled 0, 1, and 2, will appear below the plot

frame. If the plot frame were displaying points 33,767 through 34,287, the button labeled

1 would be checked. You can change sections of data by clicking the radio button for the

section you want. These buttons do not affect the stored data, as the full set of data is

stored in RAM at this point. In addition, any action such as filtering, averaging, or fast

Fourier transforming ignores these section boundaries, and the data is treated as one con-
tinuous set.

Horizontal Scroll Bar: Acts like any standard Macintosh scroll bar and, in effect, translates

the plot frame over the data. The numbers just below each end of the bar are the starting

and ending x-values viewed in the plot frame, in the units indicated.

Title Area: Displays the file name for the data shown in the plot window, and the comments

stored with the data during data import (section 4.2.1, fig. 5) or data acquisition
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(section 4.2.4, fig. 10). In addition, the analog gain, analog attenuation, and calibration

gain in decibels is shown if the data type is Acoustics. When the data in the window is the

result of an FFF, the name of analysis window used is also shown in this area.

4.3.2 Displaying Time History Data- To create and display a plot of raw, averaged, or digitally

filtered time-history data:

1. Choose Time History from the Plot menu (see fig. 2). A hierarchical menu is displayed with

two choices, Go and Options.

2. To define, or redefine, the units for the plot's x and y axes, choose Options. This activates the

Display Options dialog box shown in figure 13.

a. Choose the desired x and y units by clicking on the appropriate radio buttons. The x-axis

choices are Points and Time, and the y-axis choices are Counts, Pascals, decibels, and General.

b. Click on the appropriate command button. The three command buttons are

Go: Accepts the radio button inputs, closes the dialog box, and creates and displays a

plot.

Continue: Accepts the radio button inputs and closes the dialog box, but does not create a

plot.

Cancel: Closes the dialog box without accepting the radio button inputs or creating a plot.

3. To create a plot using the currently defined x and y units, choose Go from the Time History

submenu. (Note: Axis units can also be defined when FFT results are plotted, but different choices

are allowed. For example, an FFT plot can have frequency on the x axis (see section 4.4.2); a time

history plot cannot. If the currently defined x unit is Frequency and you choose Go from the Time

History submenu, a time-history Display Options box will be activated automatically. Choose new

units for the x axis, and click the appropriate command button.)

4.3.3 Data Lists- Specific data points can be selected from the data plots and listed in data lists,

which are viewed in data list windows. There are four data list windows, corresponding to the four

data plot windows; data selected from a given plot window goes to the data list of the same number.

Choosing a list from the Special menu (see fig. 2) activates a hierarchical menu, whose options are

Activate: Activates the data list and makes it visible as the front window.

Deactivate: Deactivates the data list and hides its window.

Bring to Front: Brings a data list window to the front when it is active but hidden.

Clear Cells: Deletes all data in that data list and resets the data point number to 0.

To transfer data from an active data plot window to a data list (fig. 15):
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' Data List 1

Point # x Value y Value

0

I

2

3

4

5

6

7

8

9

97.0 -422.0

!64.0 -73!.0

244.0 -1271.0

310.0 2923.0

366.0 -722.0

385.0 2258,0

_DeleteRowJ I SaveList J

I PrintList J IRestoreListJ

Figure 15. Data List window.

1. Activate the data list. (Choose a list from the Special menu (see fig. 2); a hierarchical menu is

displayed. Choose Activate.)

2. Choose the corresponding data plot window from the Window menu (see fig. 2); this brings

the data plot window to the front.

3. If the cursor in the data plot window is off, turn it on by clicking on the Cursor button.

4. Position the cursor line on the x value desired (see section 4.3.1).

5. Click the mouse with the arrow pointer inside the plot frame. This will transfer the x and y
data values shown above the Cursor button to the next available row in the data list.

6. To add points to the data list, repeat steps 4 and 5.

The maximum number of rows in a data list is 200; note that the first row is numbered 0. To get

data values from several data traces to reside on the same data list, display each data trace in the

same data window sequentially and choose the values desired.

The command buttons in the data list window are

Delete Row: Deletes the row in which a cell is selected, decrements the point numbers by

one, and moves the data in the list up to fill in the deleted row.
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Print List: Prints the data in the list, with the point numbers.

Save List: Activates a file dialog box and saves the data list to the text file indicated.

Restore List: Activates a file dialog box and restores the data from the selected text file to the

current list, overwriting the data in the list.

4.4 Data Analysis

Several types of analyses can be performed after the data has been acquired. At present, these

analyses consist of averaging, calculating an amplitude spectrum, and digital filtering. In future

releases of the ALDAS Program additional types of analysis will be added, including octave and

third-octave algorithms.

4.4.1 Averaging-The ALDAS Program provides two methods of performing cycle-oriented

averaging. The first method is performed at the time of acquisition and was explained in sec-

tion 4.2.4. The second method allows the user to control the parameters of the cycle averaging in

more detail--the procedure is as follows:

1. Load the starting points of all cycles to be averaged into a data list (see section 4.3.3.) The

x units of the plot from which these points are taken must be points. (For selecting the units, see

section 4.3.2.)

2. Choose Average from the Analyze menu (see fig. 2). This activates the Average Options

dialog box shown in figure 16.

3. Enter the requested information in the editable fields and select the appropriate pop-up menu.

The options are described below:

Offset: The number of points that will be added to the starting point of each cycle. Its purpose

is to shift the resultant cycle so as not to mask the event that is being used as the trigger

for the starting point. Negative offsets are permissible except when the combination of

the first point in the data to be averaged and the offset is negative.

# points: The number of points that will be averaged in each cycle.

# cycles: The number of cycles to be averaged. The program automatically fills in the number

of cycles contained in the data list; however, any number less than this is also

permissible.

Starting Cycle: The cycle at which averaging starts. This can be used in conjunction with

"# cycles" to average a subset of the cycles named in the starting-point data list. The

default value is 0, the number of the first cycle on the data list.

22



Average Options

Offset: 1-50

# points: 12048

# cycles: 16

Starting
Cycle: I 0

Starting Points In: I

points

/cycle

Data List I I

Figure 16. Average Options dialog box.

Starting Points In: A pop-up menu whose choices are the active data lists. Any or all of Data

Lists 1 through 4 can appear. Any active data list can be chosen as the input list for the

cycle starting points.

4. Click on the appropriate command button:

Go: Accepts the inputs of the Average Options dialog box, activates an Open File dialog box,

and performs the requested average on the chosen file.

Cancel: Closes the dialog box without ,performing an average.

After the average has been completed, a file is created that has the same file name as the input data

file but begins with "Avg-". Note that this prefix is different than the prefix used if the data is aver-

aged during acquisition ("Ave-") (see section 2.4.2).

One of the versatile features of this method of averaging is that any set of starting points can be

used for any data trace. This means the starting points can be taken from a once-per-revolution pulse,

a time code signal, or a data trace with a distinctive event. The same points can then be used for all

the microphone data sets, which were digitized simultaneously with the cycle starting-point source
trace.

Besides smoothing the transients from a varying signal, this method of cycle averaging can be

used to cut sections of data from long data streams and save them in individual files. To do this,

23



choose the starting point of the cycle (that is, the starting cycle from the data list), enter the number

of points to be cut, and enter 1 for the number of cycles to average.

4.4.2 Amplitude Spectrum Analysis- Spectral analysis is performed using a butterfly FFT

routine, as in reference 3. The procedure is as follows:

1. Choose FFT Options from the Special menu (see fig. 2). This activates the FFT Options

dialog box shown in figure 17.

FFT Options

{_ All data points O Subset of data

Startingpointnumber: li
Number input data points: 024

m

Skip Factor:

Non power of two options

{_Truncate to next lower power of 2

O Fill in O's to next power of 2

i I I  on"..e]

Figure 17. FFT Options dialog box.

2. Set the parameters in the FFT Options dialog box. The fields and radio buttons are as

follows:

All data points: When checked, all data points in the input stream are used to perform the

FFT; the non-power-of-two options apply to this field.

: _ i , " L? ±

Subset of data: When checked, the starting point, number of input points, and skip factor are

used to determine which points of the input stream are to be processed.

Starting point number: The number of the first data point to be used in the FFT analysis.

Number input data points: The number of data points on which to perform the FFT; the non-

power-of-two options apply to this field.
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Skip factor: Provides a means of data decimation similar to that of viewing resolution in the

Data Plot Windows (see section 4.3.1). For example, if the value is 2, every other point is

taken from the input stream.

Truncate to next lower power of 2: Truncates the input stream so that the number of FFF

points is the maximum possible power of two, to conform to an FFT input requirement

that specifies data must have a number of points equal to a power of two.

Fill in O's to next power of 2: Adds trailing O's to the input stream so that the number of data

points equals the next higher power of two.

3. Click on the appropriate command button:

Continue: Closes the dialog box and accepts the values within it.

Cancel: Closes the dialog box without accepting the changes.

4. Choose FFT Windows from the Special menu (see fig. 2). A hierarchical menu is displayed,

listing the window functions that are available for use by the FFT. Those currently available are

Rectangular, Hanning, Tenth Cosine Taper, Quarter Cosine Taper, Kaiser-Bessel, Parzen, Welch,

and Blackman Harris. The equations and properties for these windows are contained in appendix A.

5. Choose the desired window function by highlighting it. The default is Hanning, and the

currently selected window function is indicated on the menu by a check mark.

6. Choose Amp. Spectrum from the Analyze menu (see fig. 2). A hierarchical menu is displayed

with two choices, Go and Options. These operate like the Go and Options choices in the Time

History menu; the only difference is in the allowed choices of x and y axis units in the Display

Options dialog box. For the Amplitude Spectrum, the x-axis choices are Points and Frequency, and

the y-axis choices are Counts, Pascals, and decibels. For instructions, see section 4.3.2.

A plot window is opened automatically after a spectrum is calculated, and the results are plotted

in the units requested. Figure 18 shows an FFT of a 1000-Hz calibration signal in units of decibels

versus points. Notice that the frequency resolution of the x scale is given in the label, and the data

window type is given in the title.

4.4.3 Digital Filtering- The ALDAS Program can digitally filter any stored time-history data

using one of two types of filter windows. Low-pass convolution filtering is performed in the time

domain by sweeping a filter window over the time history, as described in reference 4. Phase shift of

the resultant time history is avoided by using a symmetric window that uses future points as well as

past points in the data smoothing. Two filter windows, Hanning and Half Cosine Taper, are available

for use in filtering. The filter cutoff frequency determines the width of the data window. The data-

window is centered around the current time point. Thus, the beginning and ending data points are

handled as special cases since the data window extends over the boundaries of the available data.

The beginning of the time history is handled by taking the first number of points equal to the data

window width divided by 2, flipping them, and appending them to the beginning of the time history.
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Figure 18. FFT analysis results.

This allows the filter window to be centered on the first true data point and still have the full filter

data window width for computation. The end of the data is handled in a similar fashion. This concept

is shown in figure 19.

To perform the filtering:

1. Choose Digital Filter from the Analyze menu (see fig. 2). This activates a standard file dialog

box.

2. Use the file dialog box to choose the input file, The Filter Options dialog box shown in

figure 20 is activated.
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Figure 19. Digital filtering end-point method.

N (N + NFILT)

Filter Options

Input Data File:

Sample Rate:

Analog Filter:

Avg-e 17, mic 2

2304

15

Digital Filter Rate: [ I 0

Window Type: I Hannin_

Cancel II Continue II ChangeFile I

Figure 20. Digital Filter Options dialog box.
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3. Set the options in the Filter Options dialog box. The information and options given in this
box are described below.

Input Data File: The file chosen for raw data input.

Sample Rate: The rate at which the data was sampled.

Analog Filter: The analog filter used at the time of digitization.

Digital Filter Rate: The frequency at which to apply the low-pass filter. Note that this the

frequency at which the attenuation begins and is not the 3 or 6 dB down point frequen-

cies. To calculate the 3 or 6 dB down frequencies, multiply this frequency by 1.16 or 1.23

for the Half Cosine Taper Window and 1.22 or 1.30 for the Hanning Window.

Window Type: A pop-up menu with two window choices, Harming and Half Cosine Taper.

Change File: Button that activates a standard file dialog box and allows the user to change

the input data file. The information in the Filter Options dialog box is updated to apply to
the new file.

4. Click on the appropriate command button:

Continue: Performs the average. The file created by the digital filter function has the prefix
"Fit-" attached to the file name.

Cancel: Closes the dialog box without performing the average.

4.5 Miscellaneous Features

Several features of the ALDAS Program do not fall under the preceding sections and are

described in the following sections.

4.5.1 Saving Data as ASCII- When a data plot window is active and the front window, the data

for that window can be saved as an ASCII text file. This text file can be opened by any standard

word processing program on the Macintosh, imported to another application, or exported to a differ-

ent computer. To save data as an ASCII text file:

1. Choose Save as ASCII from the File menu (see fig. 2). This activates the ASCII File dialog

box shown in figure 21.

2. Choose the range of data to be saved by entering the first and last points of the range.

3. To include descriptive information about the data in the ASCII file, click on the Print Header

Information check box. (Be sure the box has an X in it.)
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, ASCII File .

Starting Data Point: 11

Ending Data Point: [2048

[] Print Xeader Information

Figure 21. ASCII file dialog box.

4. Click on Go to close the dialog box and save the data requested in a text file. The file will

have the same name as the input file, with "Txt-" as a prefix. To close the dialog box without saving

the data, click on Cancel.

The ASCII text file contains two parts. The descriptive information is contained in the header

part of the file and is in a free format. The data is contained in the second part of the file and is in

F15.6, tab, F15.6 format, with the x value first. Figure 22 shows a text file created using this option.

4.5.2 Editing Saved Information- Certain information attached to the data can be modified.

The procedure is as follows:

1. Choose Edit Info from the Special menu (see fig. 2). This activates a standard file dialog box.

2. Choose the data file to be modified or viewed. The file editing dialog box shown in figure 23
is activated.

3. To edit the information shown, click on the appropriate field. Note that the editable fields are

all contained in rectangles; information that cannot be changed is also displayed in this dialog box.

4. To change the data type, click on the Acoustic Data or General Data radio button.

5. To save the changes to the file, click on Continue. A prompt is activated; click on Save.

6. To close the file and dialog box without saving any changes to the file, click on Cancel in the

dialog box. If you've already clicked on Continue, a prompt has been activated; click on Cancel in

the prompt box.
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Data from file:
Data acquired on:
Analog Gain:
Calibration Gain:
Calibration Slope:
Calibration Intercept:
Analog Attenuation:
Digital Gain:
Data digitized using:
Sample Rate:

Raw-250 hz

0.0 dB
0.0 dB

4.618890e-4
1.186870e-1

0.0 dB
1.0 times

16 bits
25000 sps

Number of data points: 8192
Number of cycles: 1
AntlAIlaslng filter rate: 10000 Hz
Seconds of data per rev: 0.330000
Comment: 250 hz sine wave
Digital filter rate: -1 Hz
Data Is for a Time History
Data type Is acoustics data
x axis units are: Seconds
y axis units are: Counts
Data points:

0.000000
0.000040
0.000080
0.000120
0.0001 50
0.000200
0.000240
0.000280
0.000320
0.000360
0.000400
0.000440
0.000480
0.000520
0.000560
0.000600
0.000640
0.000680
0.000720
0.000760
0.000800
0.0OO840
0.000880

1 to 50 follow
20035.000000
21421.000000
22710.000000
23921.000000
25045.000000
26070.000000
27009.000000
27844.000000
28566,000000
29177.000000
29645.000000
29932.000000
30260.000000
30412.000000
30398,000000
30287.000000
30061.000000
29686.000000
29195.000000
28612.000000
27891.000000
27048.000000
26080.000000

Figure 22. ASCII file format.
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Info From File:
I00 hz sine

Comment:

I00 hz sine wave input

date/time: DD/MON/YR HR:MN:SC I
l

Gain: 0 ] Analog Attenuation: 0Analog
I

Digital Gain: 1.0 I CalGain: 0

CalSlope: 3.058e-5 I CalIntercept: 2.381e-8

Sample Bate: 2048 General Units: none

Points in Loop: 2048 Number of Loops: I

Analog Filter Rate: 0 A-D Bits: 16

Digital Filter Rate: 250

Digital Filter Window: HanningWindow

FFTResolution: 1.003789Hz/Line

FFTWindow: HanningWindow

Q) Acoustic Data {_ General Data

_ Cancel 1 I Continue ?

Figure 23. File editing dialog box.

4.5.3 Task Timing- The ALDAS Program indicates the progress of a requested task and an

estimate of the total time that task will take through a window like that shown in figure 24. The hori-

zontal bar is filled proportionately using the elapsed time and the total estimate of the time required

that is shown below the right-hand end of the bar. Figure 25 shows the task times required in

sec/point for the Macintosh II and Macintosh IIx. These times are greatly task dependent and are

only accurate to +10%. It should be noted that much of the time required to perform an FFT is used

in setting up the arrays to send to the FFT routine. Thus, while a coprocessor board would speed up

the analysis, the acquisition of such a board should be investigated carefully to determine if it is cost

effective for the amount of time saved. Also note that as the Macintosh CPU becomes faster and

more efficient, task timing will become moot, since the response time to any request will become
negligible.
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Figure 24. Task progress indicator.

Figure 25. Time required for ALDAS tasks.

Digital Filter

5.0 FUTURE ENHANCEMENTS OF THE ALDAS

ALDAS is an evolving system, with computing power, analog-to-digital hardware, and software

being upgraded as needed and as technology allows. As mentioned previously, new Macintosh

systems with faster CPUs and larger memories are being developed continuously. As these new

Macintosh systems become available, ALDAS will be modified to accommodate them. Likewise, the

analog-to-digital capabilities that can be tied to the Macintosh are evolving, with faster 16-bit con-

versions and more simultaneous channels becoming available.

The ALDAS Program in its present form provides the basic requirements for acoustics data
acquisition and analysis. However, it is by no means complete in its abilities. Some features that will
be added in future releases are
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• octave, third-octave, and twelfth-octave analysis

• flyover types of analysis (i.e., perceived noise level)

• a real-time four-channel oscilloscope feature

three-dimensional surface and contour graphics

histograms

additional spectral analysis features

statistical functions

the ability to calibrate data other than acoustics data

more than four data windows

• additional data windows in amplitude spectrum analysis and digital filtering

• digital-to-analog playback capability

These additional features in the software, as well as the added capabilities provided by improved

technology, will allow ALDAS to meet the needs of the acoustics community through the 1990s.

6.0 CONCLUDING REMARKS

ALDAS meets the requirements of a transportable, easy-to-use acoustics data acquisition and

analysis tool. It is specifically geared to helicopter acoustics data acquired using the YO-3A aircraft,

although it can be used with any analog source. The technology used for this system is rapidly

advancing and the current version of ALDAS should be considered a baseline configuration to which

many improvements will be made in both hardware and software.
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APPENDIX A

DESCRIPTION OF DATA WINDOWS FOR FAST FOURIER TRANSFORMS

The FFT windows used in the ALDAS Program are described in detail in references 3 and 5. The

equations for these windows are shown in this appendix, and some of their characteristics are listed

in table A1. The correction factor, C.F., is obtained from the numerical integration of the window's

equation and is used to correct the amplitude of the amplitude spectrum analysis using the window.

The FFT windows are shown in figures A1 through A8 along with the log magnitudes of the trans-

form. The log magnitudes of the transform are performed on a 250-Hz generated cosine wave whose

beginning and end points are 180 ° out of phase. For all equations, N = number of points in the FFT
window.

The equations for the data windows are

1. Rectangular:

f(x) = x i=0, 1,2 ..... N-1

C.F. = 1.0

2. Hanning:

2[ { 2r_i'_]f(x)= 1 - cos_ ---_-)J
i=0, 1,2 ..... N-1

C.F. = 1.632993

3. Cosine Taper:

f(x) = 2[1 - cos ('2rti'_]_)k NJ
otN

i=0, 1,2 ..... --
2

f(x) = 1
aN c_N ocN o_N

i =--_- + 1, -_+ 2,-_- + 3 ..... N- ---_-
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.

2[ ( 2r_i'_]s_= _-cost_)j

where for one-tenth cosine taper

o_= 0.2, C.F. = 1.069045

and for one-quarter cosine taper

a = 0.5, C.F. = 1.206045

Cosine Series:

(2ni'_ (4hi') (6_i'_-]f(x)= ao-alcos_--_-)+x a_co_l-n-) _3_ost-w)J

where for Kaiser-Bessel cosine series

a0 = 0.402430, al = 0.498040, a2 = 0.098310, a3 = 0.001220, C.F. = 1.854381

and for Blackman Harris cosine series

a0 = 0.358750, al = 0.488290, a2 = 0.141280, a3 = 0.011680, C.F. = 1.968888

5. Parzen:

f(x)= x[l-i-½(N-½(N+I)I)lj

C.F. = 1.728677

6. Welch:

f(x)=x{l-L" jj

C.F. = 1.366640

_3/ c_2V

i=N---j-- + I,N----2--+ 2, N----2- + 3 ..... N-1

i=0, 1,2 ..... N-1

i=0, 1,2 .... ,N-1
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Table A1. FFT window properties

Rectangular

Hanning

Tenth cosine taper

Quarter cosine taper

Highest

sidelobe

level (dB)

-13

-32

Scallop loss

(dB)

3.92

1.42

Worst-case

process loss

(dB)

3.92

3.18

6.0 dB

bandwidth

(bins)

1.21

2.00

-14 3.25 3.45 1.35

-15 2.24 3.11 1.57

Kaiser-Bessel -69 1.02 3.56 2.39

Blackman Harris -92 0.83 3.85 2.72

-27 1.82 3.07 1.78

-21 2.22 3.01 1.59

Parzen

Welch
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Figure A1. Rectangular window. Figure A2. Harming window.
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APPENDIX B

ACRONYMS

Acoustic Laboratory Data Acquisition System

command processing unit

fast Fourier transform

random access memory

root mean square

single inline memory module

once-per-revolution pulse
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